
 

 

 

 

 

 

 

 

 

 

About Computer Creations Series 

 



Information Technology is omnipresent in today’s world. Not only is new 
technology being developed quicker than ever before, it’s also being adopted 
faster. This makes the knowledge of Computers imperative to survive in any 
industry.  

Computer Creations series of Computer Science text books are designed to 
prepare our students for their prospective career in various fields and to provide a 
foundation in the essential skills of documentation, data processing, presentation, 
programming, desktop publishing, graphics and web design. 

The book series grew out of my technical experience in the software industry and 
the class room experience during my teaching career.  Hence, the books have a 
conversational tone, which will appeal to the student group. The aim of this series 
is not only to introduce the basics of computer science and its varied applications 
to our students, but also to create a genuine interest in them towards the subject. 
The language and content to explain the concept has been kept simple and 
pertinent, so that it doesn’t overwhelm the young minds. 

Each level of the series contains modules that cater to two broad categories of 
student minds – Logical & Creative!  While the concepts and programming will 
challenge the academically oriented students; the animation, game making and 
graphics packages will reveal the creativity of the feisty ones. 

Each chapter has been designed considering the depth of content appropriate for 
the class level and duration required to finish the topic. The book contains: - 

F Session – Chapters are divided into multiple 40 min sessions. This will help 
the teachers to come up with the comprehensive lesson plan and also the 
portions to be targeted for each assessment period. It will also help the teachers 
to organize their minds for each session. 
F Do you know – Interesting facts related to the topic. This is targeted to 
expand the interest of the students beyond the topic under discussion.  
F Student’s corner – Tips to help in lab work. This addresses the common 
mistakes made by students while using the tools under discussion as well as 
additional information about the same. 



F Teacher’s corner – Suggestions for the teachers related to installations and 
activities. This section provides tips for teachers as to how to present the topic to 
the students and to ensure that the concept has been comprehended by the 
students. It also provides links to websites for downloading the required software 
as well as instructions for the installation of the same.  
F Recap - Revision of the key concepts covered in the lesson. This helps the 
child to refresh the relevant information before moving on to the next lesson. It 
also helps teachers to conduct a quick oral/written quiz to make sure the students 
have understood the chapter well. 
F Exercises – Theory, Practical and Pictorial Questions to assess the learning. 
This section covers Q & A exercises to assess the comprehension of the subject by 
the students. It includes one word, one sentence and paragraph answers to cater 
to oral and written assessment. 
F Lab Work – Practical lesson in lab based on the concept learned.  Lab 
activity has been included to cover all the key concepts and tools explained in the 
chapter. 
F Group Activity – Chart activity for the topic to encourage team work among 
students. This is targeted to instill group harmony as well as creativity in the 
young minds. 
F Practical Projects - Sample Project Snapshots and tools used to aid 
teaching. These projects will help the teachers to visualize similar ideas to create 
their own projects.  
F Practice test – Term level Assessment test for multiple chapters. This 
covers questions for the various key concepts covered over the term. It can serve 
as a reference for the teachers, to set their own question paper for assessment. 
Computer Creations series of Computer textbooks has been compiled with the 
aim to serve as your reference guide to the world of Computers during your 
academic journey! 

         Jyothi Krishnamurthi 

 



  

Chapter	1:	 Natural	and	Man-Made	Things	 		
Objective: To understand about Natural and Man-made things around us. 
Guidelines:   
• Discuss about various natural and artificial things in our life. 
• Ask the students to point the natural and man-made things in the school 

campus. 
 
Chapter	2:	 Machines	 	
Objective: To understand about importance of machines in our life. 
Guidelines:   
• Discuss about various machines we use in our day to day life. 
• Ask the students to point the machines they can see in the classroom and in 

the school campus. 
 
Chapter	3:	 Computer	–	An	Electronic	Machine	 	
Objective: To understand about the advantages of Computer over other machines 
and the various uses of computer. 
Guidelines:   
• Discuss about how and where computers are used nowadays. 
• Ask the students to talk about where all they have seen computers. 
 
Chapter	4:	 Places	Where	Computers	Are	Used	 	
Objective: To know about the places where computers are commonly used. 
Guidelines:   
• Discuss about different places we might come across computers. 
• Ask the students to talk about where they used computer and what they did in 

the computer. 
	

 

Chapter	5:	 Parts	of	Computer	 	
Objective: To know about the basic parts of computer and their use. 



Guidelines:   
• Take the children to lab and show them different parts of the computer. 
• Ask them to identify each part. 
	 	 	
Chapter	6:	 Using	the	Computer	 	
Objective: To learn the proper way to start, use and switch off computers. 
Guidelines:   
• Demonstrate to the students the steps to switch on and off the computer. 
• Ask the students to perform the steps with proper guidance and assistance. 
• Discuss the Do’s & Don’ts to be followed in the Computer Lab.  
	
Chapter	7:	 Drawing	with	Tux	Paint				 	
Objective:  
• To learn about the use and features of Tux Paint drawing program.  
• To learn how to start and exit Tux Paint. 
• To learn how to open and save a picture in Tux Paint. 
 Guidelines:   
• Tux Paint is completely free software, released as “Open Source” software, 

under the provisions of the GNU General Public License (GPL). This means you 
may download it and install it on as many machines as you wish. 

• Tux Paint for Windows comes as two parts, the main program and the optional 
add-on 'stamps' collection.  Both the installer executables are available in 

http://www.tuxpaint.org/download/windows/. 
• Stamps installer will add readymade images to the Tux Paint window so that 

we can include them in our images. 
• You can read about the different options available in Tux Paint in the product 

website. http://www.tuxpaint.org/features/ 
• Demonstrate to the students how to identify the Tux Paint icon on the 

desktop, open Tux Paint and close Tux Paint. 
 



Chapter	8:	 Parts	of	Tux	Paint	Window	 	
Objective: To learn about the different parts of the Tux Paint window and their 
use. 
Guidelines:   
• Show the different parts of Tux Paint Window and tell the name. 
• Point the different tools in toolbar and tell their name. 
• Ask the students to repeat the name of parts and tools of Tux Paint few times. 
• Ask the students to draw the tools and write their names. 
 
Chapter	9:	 Creating	a	Picture	using	template		
Objective: To learn how to create a Picture using the readymade templates 
available in Tux Paint. 

Guidelines:   
• Show the students how to open a template in Tux Paint. 
• Show the students how to select Magic tools and choose Fill tool to apply color 

to the template. 
• Show the step to print a picture. 



Chapter	10:	Creating	a	Picture	using	Solid	Background	Color	 	
Objective: To learn how to create a picture from solid color background using 
paint brush, lines, text, shapes , stamp and magic tools. 

Guidelines:   
• The readymade pictures in stamp tool will be available in Tux Paint, only if 

you install exe for stamps in addition to the Tux Paint exe. 
Both are available in http://www.tuxpaint.org/download/windows/ 

• Show the student to use the following tools 
o New tool to open an empty image. 
o  Paint tool for drawing free hand. 
o Line and Shapes tool for drawing lines and shapes. 
o Fill Tool for applying color inside shapes. 
o Color section for selecting color for drawing and filling. 
o Stamp tool for adding readymade pictures. 

 
 

 

Chapter	1:	 How	Computer	Works			
Objective: To learn about IPO cycle and how computer works based on the 
principle of IPO cycle. 

Guidelines:   
• Discuss with the students about the IPO cycle in different machines seen 

around us- What goes in as input, what happens inside and what comes out 
as Output. 

• Point the input, output and processing devices of Computer and explain the 
name and use to the students. 

Chapter	2:	 Input	Devices	 	
Objective: To learn about different types of input devices to handle different 
formats of input to the computer. 



Guidelines:   

• Point to different input devices in the computer lab and tell their name and 
use to the students. 

• Briefly explain the use of the different parts of keyboard, mouse and any other 
input devices in the lab.  

• Ask the students to draw or stick pictures of input devices and write their 
name. 
 

Chapter	3:	 Output	Devices	 	
Objective: To learn about different types of output devices to handle different 
formats of output from the computer. 

Guidelines:   

• Point to different output devices in the computer lab and tell their name and 
use to the students. 

• Briefly explain the use of the different parts of monitor, projector, speaker, 
printer and any other output devices in the lab.  

• Show and explain how Smart class setup (if it exists) works in the class room. 
• Ask the students to draw or stick pictures of output devices and write their 

name. 
 

Chapter	4:	 Central	Processing	Unit	 	
Objective: 

• To learn about the use of CPU in the computer and their components. 
• To learn about different types of memory in the computer. 

 

Guidelines:   

• Explain to the students about CPU and its components. 
• Explain the difference between Volatile and Non-volatile memory. 
• If any old unused computers available in school, you can open the CPU box and 

show them various parts inside. 



Chapter	5:	 	Storage	Devices		
Objective: To learn about the different types of storage devices and their use 

Guidelines:   

• Explain the difference between memory and storage devices. 
• Discuss about Cloud storage like Google drive, Drop Box etc 
	
Chapter	6:	 Drawing	for	Children	 	
Objective: To know about the different features of the drawing program, Drawing 
for Children and the use of the parts of Drawing for Children window. 

Guidelines:   

• Drawing for Children is a freeware and are available for download in many 
sites. 
http://ccm.net/download/download-17045-drawing-for-children. 

 
• In addition to the usual drawing and painting tools a range of stamps, abstract 

shapes, clipart and artistic effects are included. 
• Name aside, it is also an appropriate intro program for older users with 

learning disabilities. 
• Point the different parts of Drawing for Children window and tell their name. 

 



Chapter	7:	 Tools	in	Drawing	for	Children	 	
Objective:  

• To know about the various tools in Drawing for Children and their use. 
• To learn how to open, save and print images in Drawing for Children. 
Guidelines:   

• Point and explain the different tools in toolbar to the students. 
• Ask the students to draw the tools and write their name. 
• Show how to open, close, save and print pictures in Drawing for Children. 

 

Chapter	8:	 Picture	with	Readymade	Background	 	
Objective:  

• To learn how to create a picture using readymade background and clipart 
provided by Drawing for Children. 

• To learn how to add text and apply special effects to the image. 
Guidelines:   

• Font button will only work when the setting Enable font selection is checked in 
Settings. 

• Use Shift key to make the clipart images bigger while adding. 
• Demonstrate to the students how to perform the following actions in Drawing 

for Children. 
o Starting Drawing for Children.  
o Opening an empty image using the New button in Tool bar. 
o Choosing readymade Background for the image.  
o Adding readymade images using Cliparts tool. 
o Using Text tool to type on the image. 

Chapter	9:	 Picture	with	Solid	Color	Background	 	
Objective: To learn how to create images from scratch using background color, 
stamps, special things, lines and shapes.  

Guidelines:   

• Use Ctrl key to create random effects for different tools. 



• Alt key helps us to draw straight lines. 
• Demonstrate to the students how to perform the following actions in 

Drawing for Children. 
o Applying background color using Fill tool. 
o Using Sketch lines tool to draw free hand. 
o Using Stamp tool to add readymade images 
o Adding Special things like trees, buildings and designs. 

 

 

Chapter	1:	 Mouse	
Objective:  To learn about the use of mouse and the different parts, the different 
actions performed using the mouse and the different types of mouse available in 
the market. 

Guidelines:   

• Point to the various parts of mouse and tell the name and use. 
• Show them the right and wrong ways of holding the mouse. 
• Discuss about the types of mouse in different gadgets. 
• Read more about different types of computer mouse  

http://www.dummies.com/computers/pcs/mice/the-different-types-of-computer-
mice/ 

• Demonstrate the use of various mouse actions and ask them to practice the 
same. 

• Ask them to draw a mouse and label the parts. 
 

Chapter	2:	 Keyboard	
Objective:  To learn about the use of keyboard and the different types of and the 
different types of keyboards. 

Guidelines:   



• Point to the various keys in the keyboard and tell the name and use. 
• Discuss about the types of keyboards in different gadgets. 
• Demonstrate the use of various keys and ask them to practice the same. 
• Read about different types of keyboards 

https://readanddigest.com/different-types-of-computer-keyboards/ 
 

Chapter	3:	 Typing	with	Notepad		
Objective:  To learn about the use of notepad and the various tools available in 
notepad to create and edit text files. 

Guidelines:   

• Microsoft Notepad is included with all versions of Windows. It is available 
under the Accessories option in the Start Menu. 

• Demonstrate to the students the following actions in Notepad. 
o Starting Notepad 
o Opening a new file or existing file 
o Saving a file 
o Printing a file 
o Formatting text using Font Option 
o Inserting Date & Time 
o Searching and Replacing text  

• You can read more about Notepad in  
http://www.thewindowsclub.com/basic-notepad-tips 

Chapter	4:	 Operating	System	
Objective:   

• To learn about basic components of computer – Hardware and Software. 
• To learn about the classifications of Software. 
• To learn about different types of operating system and their use. 
 Guidelines:   

• Point out the different hardware and software in the computer lab. 



• Name a device/application and ask whether it is a hardware or software. 
• Discuss about the various operating system used in gadgets, phones, vehicles 

etc. 
• You can read about various types of operating system here. 

https://techspirited.com/different-types-of-operating-systems 
 

Chapter	5:	 	Working	with	Windows	
Objective:  To learn about Windows operating system and desktop. 

Guidelines:   

• Point at the different parts of Windows Desktop and tell their name and use. 
• Demonstrate to children the use of various icons on the desktop and taskbar. 
• Demonstrate how to change the desktop background and changing date and 

time. 
• You can read more about the different Window elements and their use here. 

https://worldofinfotech.wordpress.com/tag/basic-window-elements/ 
 

Chapter	6:	 Stick	Figure	Animation	with	Stykz	
Objective:   

• To know about the features of Stykz animation software. 
• To learn about the parts of Stykz Workspace and their use. 

 

Guidelines:   

• Stykz is a freeware and can be downloaded from the product website.  
https://www.stykz.net/downloads/windows.php 



 
• You can read about the various features of Stykz here. 

https://www.stykz.net/stykz.php 
• Point at each part of the Stykz workspace and tell the name and use. 

Chapter	7:	 Tools	in	Stykz	
Objective:   

• To know about the features of Stykz animation software. 
• To learn about the parts of Stykz Workspace and their use. 

 
Guidelines:   

• Explain the difference between Default and Blank document. 
• Explain the difference between Stykz figure and Pivot 2 figure. 
• Show and explain nodes and segments. 
• Show and explain the use of various palettes and the options in Stykz. 
• Demonstrate to the students how to perform the following actions in Stykz. 

o To start, open, close and save stykz document. 
o To apply background color using Stage Properties. 
o To format stick figure using Figure Properties. 
o To draw shapes using Add Circle tool and Add Line tool. 



o To fill color in shapes using the Polyfill tool. 
• You can read more about tools, palettes and features here. 
https://www.stykz.net/support/help/Stykz_Online_Help.php 

 

Chapter	8:	 Creating	Animation	with	Stykz	
Objective:  To learn how to create stick figure animations using the tools and 
palettes in Stykz. 

Guidelines:   

• If any of the palettes are missing, go to Window Menu and check the required 
option from the drop down. 

• Demonstrate to the students how to perform the following in Stykz. 
o Adding a new Stykz figure 
o Adding a new frame 
o Moving the figure using drag node 
o Rotating the segments using Pivot node 
o Adjusting the speed of animation 
o Playing the animation once and in loop 
o Exporting the animation as animated GIF and viewing in browser 



 

Chapter	1:	 History	of	Computers	
Objective:  To learn about the history of computers and how it has evolved over 
the years. 

Guidelines:   

• Discuss about the recent developments in Computers. 
• Ask the student to find out and write/talk about one invention or technology 

related to computers. 
• You can read about the history of computing in this website. 
https://www.britannica.com/technology/computer/History-of-computing 

Chapter	2: Computer	Pioneers	

Objective:  To learn about some pioneers who have played a major role in the 
growth of the computer technology! 

Guidelines:   

• Talk about famous people in computers today like Sundar pichai of Google etc. 
• Ask students to find out information about any founder in the IT field and 

talk/write about them. E.g.:  founder of flipkart etc. 
• You can read about some pioneers in computing in this webpage. 

https://www.techopedia.com/2/27836/development/programming-tools/the-
pioneers-of-computer-programming 
 

Chapter	3: Generations	of	Computer		

Objective:  To learn about the different generations of computer and technology 
used in them. 

Guidelines:   

• Discuss about how the development in computers has been categorized based 
on the technology.  



• Try to show them some pictures or video of the various generations. 
• Ask students to find out information about recent invention or development in 

Artificial Intelligence. 
• You can read more on the generations of computers in this webpage. 

https://www.webopedia.com/DidYouKnow/Hardware_Software/FiveGenerati
ons.asp 
 

Microsoft	Paint	

Chapter	4	 Introduction	to	Microsoft	Paint	
Objective:  

• To know about Microsoft Paint program and its features. 
• To learn about the parts of MS Paint window and their use. 
• To learn how to create, open, save and print images in MS Paint. 
Guidelines:   

• Microsoft Paint is a simple graphics editing program that is included with 
Microsoft Windows. 

• Demonstrate to the students how to start MS Paint and to create, save and 
print images in it. 

• Point at the parts of MS Paint window and tell their name and use. 
 

Chapter	5	 	Tools	in	MS	Paint	
Objective:  To learn about the various menus and tools in MS Paint and their use 
in creating images. 

Guidelines:   

• Point at the various menus and the tools in MS Paint and tell their name and 
use. 

• Ask the students to draw the tools and write the name. 
• You can read more on the use of various tools in MS Paint in this web page. 

https://www.wikihow.com/Use-Microsoft-Paint-in-Windows 



 

Chapter	6	 Editing	Image	in	MS	Paint	
Objective:  To learn how to edit and format images in MS Paint. 

Guidelines:   

Demonstrate to the students how to perform the following actions in MS Paint. 

• Selecting the whole image or a part of image 
• Resizing the image  
• Cropping the image 
• Rotating the image 
• Zooming in or out of the whole image or a part of image 
 

Chapter	7	 Drawing	in	MS	Paint	
Objective:  To learn how to draw and create images in MS Paint. 

Guidelines:   

Demonstrate to the students how to perform the following actions in MS Paint. 

• Applying background color to the image 
• Drawing readymade shapes in MS paint and applying fill and outline colors 
• Drawing freeform using brush or pencil tools and choosing different brush 

types, size and colors. 

Scratch	

Chapter	8	 Introduction	to	Scratch	
Objective:   

• To know about the use of Scratch and its features. 
• To know about the different sections and palettes of Scratch workspace and 

their use. 
• To learn how to start Scratch and to create, open, save or import projects in 

Scratch. 



Guidelines:   

• Scratch is a free visual programming language used to create interactive 
stories, games, and animations. Scratch is developed by the Lifelong 
Kindergarten research group at the MIT Media Lab.  

• Sprite is a freeware available for download in the product site. 
https://scratch.mit.edu/scratch_1.4/ 

 
• Demonstrate to the students how to start Scratch, open Scratch project, save 

and exit. 
• Point at the parts of Scratch window and tell their name and use. 

 

Chapter	9	 Working	with	Scratch	
Objective:  To learn how to work with sprites, sounds and scripts in Scratch 
projects. 

Guidelines:   

• Demonstrate to the students how to perform the following actions in Scratch. 
o Adding Background to Stage 
o Adding a Sprite 
o Resizing a Sprite 



o Moving a Sprite using Motion Block 
o Adding Sound using Sound Block 
o Building scripts using Control blocks 
o Using Green flag and Stop button for running the scripts 

• You can read more on how to create Scratch projects in the website 
https://scratch.mit.edu/projects/editor/?tip_bar=getStarted 

Chapter	10	 Animations	in	Scratch	
Objective:  To learn how to create animations in Scratch using Costumes and 
Looks Block  

Guidelines:   

• Demonstrate to the students how to perform the following actions in Scratch. 
o Adding Costumes for Sprites 
o Changing Costumes of Sprites using Scripts from Looks block 
o Changing colors of Sprites using Looks block 
o Adding Think or Talk Bubble using Looks Block 

 

 

Chapter	1	 Types	of	Computers	
Objective:  To know about different types of computers categorized based on 
their power and size. 

Guidelines:   

• Discuss about the different types of computers and their use. 
• Discuss with students about the different microcomputers used in day to day 

life. 
• You can read more about various types of computers in this webpage. 
https://en.wikiversity.org/wiki/Types_of_computers 



Windows	Explorer	

Chapter	2	 Introduction	to	Windows	Explorer		
Objective:   

• To know about the various uses of Windows Explorer. 
• To learn about the parts of Windows Explorer window and their use. 
Guidelines:   

• Demonstrate different ways of opening Windows Explorer. 
• Show the different parts of Windows Explorer window and tell their name and 

use. 
• Icons and menus might be different in various versions of Windows.  
• You can read about different ways of opening Windows Explorer in this 

webpage. 
https://www.wikihow.com/Open-Windows-Explorer 

Chapter	3	 Using	Windows	Explorer	
Objective: To learn about the different actions that can be performed in Windows 
Explorer! 

Guidelines:   

• Depending on the version of Windows OS, the menus and layout of the 
Explorer window might differ! 

• Demonstrate to the students how to perform the following actions in 
Windows Explorer. 

o Open a document  
o Open a program 
o Search for a file or folder 
o Copy file or folder 
o Move  file or folder 
o Delete file or folder 
o Rename  file or folder 
o Create a shortcut to file or folder 



• You can read more on how to work with files in Windows Explorer in this 
webpage. 
https://www.webucator.com/tutorial/windows-7/index.cfm 

Chapter	4	 Microsoft	Office	
Objective:  
• To learn about the use of computers in office management 
• To learn about the use of Microsoft Office package and the different versions. 
• To learn about the different applications included in MS Office suite and their 

use. 
 

Guidelines:   
• To see the applications included in the Microsoft Office Suite in your system, 

go to Start menu è All Programsè  Microsoft Office.  The list of applications 
will be displayed below Office option. 

• Discuss with students about the use of different versions of MS Office suite. 
• Discuss with students about the use of various applications included in MS 

Office Suite. 
• You can read more about MS Office, versions and applications in Wikipedia. 

https://en.wikipedia.org/wiki/Microsoft_Office 

Microsoft	Word	

Chapter	5	 Introduction	to	Microsoft	Word	
Objective:  
• To learn about the use of Microsoft Word and its features. 
• To learn about the use of different parts of MS Word Window. 
• To learn about the various file operations performed in Word. 
 
Guidelines:   
 
• Point out the different parts of MS Word window to the students and tell their 

name and use. 
• Demonstrate to the students the following actions in MS Word. 



o Starting MS Word 
o Creating a new document 
o Opening an existing document 
o Saving a document 
o Printing a document 

• You can read more about the use of various parts of MS Word window in this 
webpage. 
https://www.officetutorial.net/word/microsoft-word-2007-and-2010-parts-
and-controls/387/ 

 

Chapter	6	 Text	Formatting	in	MS	Word	
Objective: To learn about the text formatting tools in MS Word and their uses. 
Guidelines:   
• Point at the various text formatting tools and tell their name and use. 
• Demonstrate to the students how to perform the following text formatting in 

MS Word. 
o Changing Font Style, Size and Color 
o Highlighting Text 
o Changing Text Case 
o Aligning Text 
o Changing spacing between lines and paragraphs 
o Applying Bullets and Numbering 
o Searching and Replacing text 

• You can read more on text formatting in Word in this webpage. 
https://www.universalclass.com/articles/computers/formatting-in-ms-word-
2007.htm 

Chapter	7	 Inserting	Graphics	in	MS	Word	
Objective: To learn how to add shapes, images, charts, tables, word art, textbox 
etc. using the Insert Tab in MS Word. 

Guidelines:   
• Point and tell the name and use of the various tools in Insert tab. 



• Demonstrate to the students the following actions using various tools in MS 
Word. 

o Inserting and Formatting Picture & Clipart 
o Inserting and Formatting Shapes 
o Adding and Formatting text using WordArt and TextBox tools 
o Adding and Formatting tables  

• There are many formatting tools in Format tab which are common for Shape 
and WordArt such as Shape fill, Shape Outline, Change Shape, Shadow Effects, 
3 D Effects, Position, Align and Rotate. 

• You can learn about the use of Illustrations, Tables and Text tools in MS Word 
in this webpage. 
http://www.free-computer-tutorials.net/word-2007-illustrations.html 
http://www.free-computer-tutorials.net/word-2007-tables.html 
http://www.free-computer-tutorials.net/word-2007-text.html 
 

Chapter	8	 Page	Design	in	MS	Word	
Objective: To learn how to design the layout of the page in Word document using 
the different tools in Page Layout and Insert tabs. 
 

Guidelines:   
• Point and tell the name and use of various tools used to design the layout of 

the page in MS Word. 
• Demonstrate to the students how to change the orientation, size, margin, 

color, border and background for the page in Word. 
• Demonstrate how to apply watermark, page number and date/time. 
• Demonstrate how to add text or images for Header and Footer in Word. 
• You can read more about the tools in Page Layout tab and Header and Footer 

section in these web pages. 
http://www.learningcomputer.com/ms_word_page_layout_tab/ 

http://www.free-computer-tutorials.net/word-2007-header-footer.html 



 

Microsoft	PowerPoint	

Chapter	1:	 Introduction	to	PowerPoint	

Objective: 
• To learn about the importance of presentation software. 
• To know about the use of Microsoft PowerPoint and its features. 
• To learn about the use of various parts of MS PowerPoint window. 

 
Guidelines:   
• Demonstrate how to launch Microsoft PowerPoint using Start Menu. 
• Point out the parts of MS PowerPoint window to the students and tell their 

name and use. 
• You can read more about the use of various tools and parts of MS PowerPoint 

in this web page. 
https://www.microsoftpressstore.com/articles/article.aspx?p=2192909 

Chapter	2:	 Getting	started	with	MS	PowerPoint	
Objective: To learn how to use the different parts of MS PowerPoint to create 
presentation files. 

 
Guidelines:   
• The Menu and tool options might differ based on the version of PowerPoint. 
• Demonstrate to the students how to create, open, save and print MS 

PowerPoint presentation.  
• Demonstrate how to play slideshow in different ways. 
• Demonstrate how to add new slide, choose layout, delete slide and also to 

move slide to another position. 
• You can read more on the file and slide operations in the web page. 

http://www.electricteacher.com/tutorial3.htm 
You can read about slide layout in this page. 



https://support.office.com/en-US/article/what-is-a-slide-layout-99da5716-
92ee-4b6a-a0b5-beea45150f3a 

Chapter	3:	 Slide	Background	in	MS	PowerPoint	
Objective:  
• To learn how to apply themes, background style and size for the slides in MS 

PowerPoint presentation! 
• To learn how to display slide number, date & time and text using header and 

footer tools 
 

Guidelines:   
• Demonstrate to the students how to apply different themes and the 

background styles for each theme. 
• Encourage the students to experiment with various themes and background 

styles. Ask them to note down the name of various themes. 
• Demonstrate the use of Header and Footer tool in the Insert tab to display 

slide number, date and time and any text as header/footer. 
• Demonstrate how to change the orientation and size of the slides in a 

presentation to suit the size of the display screen or print paper. 
• You can read more about the above operations in the page. 

https://support.office.com/en-us/article/design-your-slides-53c20bd5-e594-
4837-a7ad-525706e09960?ui=en-US&rs=en-US&ad=US#PowerPoint-
Design=Backgrounds_and_theme 

Chapter	4:	 Text	Formatting	in	MS	PowerPoint	
Objective: To learn how to learn how to add and format text in MS PowerPoint 
presentation. 

 
Guidelines:   

• Demonstrate the following actions to add and format text in a PowerPoint 
slide. 

o Adding and formatting text using placeholder, textbox and WordArt. 



o Formatting text using the tools available in the Font and Paragraph 
sections in Home tab. 

o Changing text case, alignment and character spacing. 

• Ask the students to draw the tools and write their name. 

• You can read more about text formatting in MS PowerPoint in this page. 

https://www.universalclass.com/articles/computers/how-to-work-with-text-
in-powerpoint-2007.htm 

Chapter	5:	 Graphics	in	MS	PowerPoint	
Objective: To learn how to add images and shapes, format and animate them in 
MS PowerPoint presentation. 

 
Guidelines:   

• Demonstrate how to perform the following actions in MS PowerPoint. 

o Adding and formatting pictures and clipart 

o Adding audio and video to the presentation 

o Applying animations and effects to text, shapes and images 

o Applying transitions to slides  

• You can read more about adding animations and multimedia to PowerPoint in 
this web page. 

https://www.microsoftpressstore.com/articles/article.aspx?p=2192910 

Microsoft	Excel	

Chapter	6:	 Introduction	to	Microsoft	Excel		
Objective:  
• To learn about spreadsheet and its use in accounting. 
• To learn about Microsoft Excel and its features. 
• To learn about the use of the various parts of Excel window. 

 
Guidelines:   



• Talk about how accounts were maintained in olden days.  
• Demonstrate how to launch MS PowerPoint using Start menu. 
• Point out the parts of MS Excel window to the students and tell their name and 

use. 
• You can read more about the evolution of spreadsheet in this webpage. 

http://www.software-matters.co.uk/spreadsheets.html 
 

Chapter	7:	 Getting	Started	with	MS	Excel	
Objective: To learn how to use the various tools in Microsoft Excel to create 
spreadsheets. 

 
Guidelines:   

• Demonstrate the use of keyboard keys to navigate the cells in the worksheet. 

• Demonstrate how to perform the following actions in MS Excel. 

o Creating a new Excel Workbook 

o Adding, Renaming , deleting ,moving or copying a worksheet 

o Entering data in a cell 

o Using the formatting tools for the data and the cell 

o Changing the alignment and direction of the cell contents 

o Merging Cells 

o Number formatting to display currency, percentage, date and time etc 

• Ask the students to draw the tools and write their names. 

• You can read more about excel worksheets in this web page. 

http://www.excel-easy.com/basics/worksheets.html 

Chapter	8:	 Formatting	Cells	in	Excel	
Objective: To learn how to format the cells in the worksheet by inserting or 
deleting rows and columns or adjusting the width of columns and height of rows. 
 



Guidelines:   

• Demonstrate to the students how to perform the following actions in the 
worksheet. 

o Inserting and deleting rows and columns. 

o Adjusting the column width and row height by specifying fixed value or 
using Autofit option. 

o Specifying row and column titles to be repeated for printing. 

• You can read more about Excel tables in this web page. 

https://support.office.com/en-us/article/overview-of-excel-tables-7ab0bb7d-
3a9e-4b56-a3c9-6c94334e492c 

Chapter	9:	 Data	Processing	using	MS	Excel	
Objective: To learn how to use MS Excel tools to create charts and perform 
calculations using formula and functions. 
Guidelines:   
• Demonstrate to the students the following actions in MS Excel. 

o Sorting data numerically and alphabetically in ascending and descending 
order based on specific columns. 

o Autofill sequence of data like serial numbers, month, year etc 
o Adding formula to a cell manually  
o Adding function to a cell manually or using Function library 

• Explain the use of charts and demonstrate how to create different types of 
charts for the same data. 

• Demonstrate how to format the chart to change Chart style, Chart layout, 
Chart Title, Axes Title, Chart Wall, Chart Floor ,Text Style etc. 

• Based on the chart type, the tool options available in the Design, Layout and 
Format tabs will differ. 

• Ask the students to try out different layout and format options for each chart 
type. 

•  
• You can read about how to create a chart in excel in this webpage. 



https://support.office.com/en-us/article/create-a-chart-from-start-to-finish-
0baf399e-dd61-4e18-8a73-b3fd5d5680c2 

• You can read more about formula and functions in excel in this webpage. 
https://www.ablebits.com/office-addins-blog/2017/06/14/basic-excel-formulas-
functions-examples/ 

 

 

Network	Basics	

Chapter	1:	 Network	Basics	

Objective:  
• To learn about data communication and its components. 
• To learn about computer network and its advantages. 
• To learn about different types of network. 

 
Guidelines:   
• Discuss with students the different ways of conducting personal, business and 

mass communication. 
• Ask the students to choose and talk about any one communication technology. 
• Show and explain the LAN and Internet connectivity in the computer lab. 
• Discuss the different networks we can see around us in school, home, airport, 

shopping mall etc. 
• You can read more about different types of network in this web page. 

https://www.studytonight.com/computer-networks/types-of-networks 
	

Chapter	2:	 Internet	

Objective:   
• To learn about the Internet, its related technologies and their use. 
• To learn about the various services provided by Internet. 



• To learn about the various Internet protocols and their purpose. 
• To learn about different types of internet connections. 
 
Guidelines 
• Discuss the different uses of the Internet in our day to day life. 
• Ask the students to talk about how, where and for what purpose they have 

used the Internet. 
• Explain the use of various Internet Protocols. 
• Discuss the different types of Internet connections. 
• Take the students to Lab or Library where there is Internet connection and 

show them how the devices are connected. 
•  Ask the students to find out the kind of Internet access and connectivity 

available at home and talk about it to the class. 
• You can read more about Internet and their uses in this webpage. 

https://www.gcflearnfree.org/internetbasics/ 
HTML	

Chapter	3:	 Hyper	Text	Markup	Language		

Objective:   
• To learn about WebPages in the World Wide Web and how HTML is used to 

develop these web pages. 
• To learn about Search Engines and Web browsers 
• To learn about Websites and Web pages 
• To learn about the use of HTML and various HTML tags. 
• To learn how to create and save a HTML document and view it in web 

browser. 
 
Guidelines 
 
• Demonstrate the difference between Web browsers and Search engines to the 

students.  



• Ask the students to talk about the websites they have visited, their URL and 
content.  

• Discuss with the students about the URL of the school website and its 
homepage. 

• Explain the basic structure of a HTML document and use of the tags. 
• Demonstrate saving the HTML document in notepad and opening it using a 

web browser. 
• You can read more about HTML basic structure in this web page. 

http://www.simplehtmlguide.com/whatishtml.php 
	

Chapter	4:	 Text	Formatting	with	HTML	

Objective:  To learn how to specify text formatting for web pages using HTML 
tags. 
 

Guidelines 
• Demonstrate to the students the use of the Heading Tags, Paragraph Tag, Line 

Break Tag and Text Formatting tags. 
• Demonstrate the use of HTML style attribute for specifying font style, size and 

color for the text. 
• Demonstrate to the students the use of color name and hexadecimal code to 

display text in different colors. 
• Ask the students to find any 10 colors supported by HTML and write down 

their names and hexadecimal code. 
• You can read more about the text formatting tags of HTML in the web page. 

http://www.simplehtmlguide.com/text.php 
 

Chapter	5:	 Organizing	Information	Using	HTML	

Objective: To learn how to organize data in the form of lists and tables. 

Guidelines 



• Demonstrate to the students how to display information in the form of various 
types of lists in HTML- Ordered List, Unordered List, Definition List and 
Nested List using HTML tags. 

• Demonstrate to the students how to arrange data like text, images, links, lists 
etc. into rows and columns of cells using HTML Table tags. 

• You can read more about the List and Table tags of HTML in the web page. 
http://www.simplehtmlguide.com/lists.php 
http://www.simplehtmlguide.com/tables.php 

Chapter	6:	 Images	in	HTML	

Objective:  

• To learn how to display images, scrolling text and background on a 
webpage. 

• To learn how to navigate from one web page to another using hyper links. 
 

Guidelines 
• Demonstrate to the students how to images on a web page by using <img> 

tag.  
• Demonstrate the use of various attributes to control the size, position and 

border thickness of the image. 
• Demonstrate to the students how to specify a color or an image as background 

for the webpage using the attributes bgcolor and background in the <body> 
tag. 

• Demonstrate to the students how to display scrolling texts or images on a 
webpage by using <marquee> tag. 

• Demonstrate to the students how to control the speed and direction in which 
the text or image moves on the web page using different attributes of the 
Marquee tag. 

• Demonstrate the use of hyperlinks in various websites to navigate from one 
webpage to another. 

• Show to the students how the images and text act as hyperlinks to other web 
pages and demonstrate how they are used. 



• Demonstrate to the students how to create a hyperlink on any image or text to 
link to another HTML page using anchor <a> tag. 

• Demonstrate to the students how to arrange information in rows and columns 
of cells using HTML Table tags. 

• You can read more about use of image tags, marquee tags and hyperlinks in 
the web pages given below. 

http://www.simplehtmlguide.com/images.php 

http://www.simplehtmlguide.com/linking.php 

https://way2tutorial.com/html/html_marquee_tag.php 

SCRATCH	

Chapter	7:	 Scratch	Workspace	

Objective:  

• To learn about the basic components of Scratch and their use. 
• To learn about the different parts of Scratch workspace and their use. 
• To learn about the various options in Scratch menu bar and their use. 

 
Guidelines 
• Scratch is a visual programming language used to create interactive stories, 

games and animations. Scratch is developed by the Lifelong Kindergarten 
Group at the MIT Media Lab, with financial support from the National Science 
Foundation, Microsoft, Intel Foundation, Nokia, and the MIT Media Lab 
research consortia. 

• Scratch is a freeware available for download in the product site. 
https://scratch.mit.edu/scratch_1.4/ 

• An introduction to the Scratch tool and Animations using Scratch are covered 
in Knowledge Computer Creations – Class 4 text book. 

• Demonstrate starting Scratch application, opening a new Scratch Project and 
saving the file in the computer. 



• Point to the different parts of Scratch workspace and tell the name and use of 
each. Ask the students to repeat the same. 

• You can read more on how to create Scratch projects in the website 
https://scratch.mit.edu/projects/editor/?tip_bar=getStarted 

Chapter	8:	 Working	with	Scratch	Components	

Objective: To learn how to create animations and games using the various 
components of Scratch - Sprites, Costumes, Blocks, Scripts, Sound, Background 
and Stage.  

Guidelines 
• Demonstrate the following actions to the students 

o To change the stage background 
o To import sprites to add images to the animation 
o To animate sprites by adding and changing costumes 
o To import sound files into the project 
o To create script by adding various types of blocks – Motion, Looks, 

Sound , Control etc. 
o To run and stop the script for the Scratch animation 
o To view the project in different presentation modes 

• Encourage the students to create their own background or sprite by editing 
them in the Paint Editor in Scratch workspace.  

• Scratch has provided many sample scripts for the sprites. When you import a 
new sprite from the Scratch folders, we can see many sprites with the number 
of scripts displayed with it. These will be useful to understand the use of 
different blocks to create script. 

• You can read more on Scratch in this website 
https://en.scratch-wiki.info/wiki/Getting_Started_with_Scratch	

	

 

Chapter	1	 Malware	



Objective: To learn about different types of malware and how they affect the 
system and the users. 

Guidelines 
• Explain to the students about Malware and the symptoms of infection. 
• Discuss about various types of malware with examples. 
• Ask students to find out the details of any popular malware/virus and 

talk/write about it. 
• Explain to the students how to prevent malware infection. 
• You can read more about various types of malware in this webpage. 

https://www.lastline.com/blog/malware-types-and-classifications/ 
 

Chapter	2	 Introduction	to	Computer	Graphics	

Objective:  

• To learn about computer graphics and its uses. 
• To learn about the two types of graphics – Raster and Vector. 

Guidelines 
• Explain to the students the uses of Computer Graphics in the real life. 
• Explain to the students the difference between Raster Graphics and Vector 

graphics. 
• Read more about computer graphics in this website. 

http://www.allgraphicdesign.com/graphics/comptutergraphics101.html 
 

GIMP	

Chapter	3	 Introduction	to	GIMP	

Objective: 

•  To learn about the use and features GIMP  
• To learn about the parts of GIMP Workspace and their uses 
• To learn about the various color modes supported by GIMP 

 



Guidelines 
• The GIMP is a Free and Open Source Software application covered by the 

General Public License. The GPL provides users with the freedom to download, 
access and alter the source code of the software. 

• GIMP can be downloaded from http://www.gimp.org. 

 
• Explain to the students the various features of GIMP. 
• Point and explain the name and use of various parts of GIMP Workspace. 
• Demonstrate to the students how to toggle between various color modes and 

window modes. 
• You can read more about GIMP in this website. 

https://docs.gimp.org/en/introduction.html 
 

Chapter	4	 Working	with	GIMP	Files	

Objective:  To learn how to create, open, save and export images in GIMP 

Guidelines 
• Demonstrate to the students the following actions in GIMP 

o Creating New Image using various options in File Menu. 
o Opening an image in different ways using File Menu. 



o Saving the file in three ways using File menu. 
o Exporting the image in various formats.  

• You can read more about the different File Menu options in GIMP in this 
website. 

https://docs.gimp.org/en/gimp-file-menu.html 

Chapter	5	 Tools	in	GIMP	

Objective:  To learn about the different tools in GIMP and their use. 

 Guidelines 

• Point and tell the name and use the various tools available in GIMP workspace. 
• The various tools are categorized based on their use and are available under 

different menus. 
• You can read more about the tools and their use in this website. 

https://docs.gimp.org/en/menus.html 
	 	

Chapter	6	 Creating	Images	in	GIMP	

Objective:  To learn how to use the different tools in GIMP to create images. 

Guidelines 

• Demonstrate the following actions to the students 
o Applying Background color using the Foreground/Background indicator, 

Gradients or Patterns. 
o Drawing shapes or to selecting part or whole of the image using Select 

tools. 
o Adding text to image using Text tool. 
o Saving and exporting the image. 

• You can read more about the selection tools in GIMP in this website. 
https://docs.gimp.org/en/gimp-tools-selection.html 

Chapter	7	 Image	Enhancement	with	GIMP	



Objective:  To learn how to modify images by applying different special effects 
and transformations using GIMP tools. 

 
Guidelines 

• Demonstrate the following to the students in GIMP 

o Using  various tools to change the color of the image  

o Converting an image to its negative or black and white 

• Demonstrate to the students the use of different types of filters, the 
various options for each filter and the changes made on the images using 
them. 

• Encourage the students to experiment with the filter tools and ask them to 
note down the observations. 

• The Preview option has to be checked for the color and filter tools to view 
the changes in the image before confirming with OK button.   

• Demonstrate to the students how to create animation from images in 
GIMP using animation filters. 

• You can read more about filters in GIMP in this website. 

https://docs.gimp.org/en/gimp-filters-menu.html 

 
Chapter	8	 Programming	Concepts	

Objective:   

• To learn about the basics of software concepts. 

• To learn about various programming languages and translators. 

• To learn about program development life cycle. 
Guidelines 

• Explain to the students the following concepts 

o Hardware and Software 



o Computer program and programming 

o Three levels of programming languages 

o Compiler and interpreter 

o Phases in program development 

• You can read more about the software concepts in the website. 

http://www.rcppmail.org/Fundamental/software_concept.htm 
	

Chapter	9	 Algorithm	

Objective:   

• To learn about the use of algorithm and their properties. 

• To learn about two types of algorithm – pseudocode and flowchart. 

• To learn about different types of programming statements. 
Guidelines 

• Explain to the students the use, properties and examples of algorithm. 

• Discuss the different algorithms used in various games and apps. 

• Ask the students to find information about any popular algorithm and its 
use and write/ talk about it. 

• Discuss and differentiate the use of two tools of algorithm – Flowcharts and 
Pseudocode. 

• Explain the three types of programming statements and their use. 

• Ask students to write pseudocode and draw flowcharts for various 
algorithms. 

• You can read more examples of algorithms and programming statements in 
the website. 

https://www.dyclassroom.com/flowchart/exercise-1 
C++	



Chapter	10	 Introduction	to	C++	

Objective:   

• To learn about programming paradigms and their types. 

• To learn about the various phases of C++ program. 

• To learn about the basic structure of C++ program 
Guidelines 

• Explain about programming paradigms and their types used in developing 
programs. 

• Explain about the various phases in developing, compiling and executing a 
C++ program. 

• Demonstrate the use of Dev-C++ for compiling and running a C++ program. 

• Orwell Dev-C++ is a free full-featured integrated development environment 
(IDE) distributed under the GNU General Public License for programming in 
C and C++. 

• To install the Dev-C++ software,   

o Download Dev-C++ from https://sourceforge.net/projects/dev-cpp. 

o Double click on the setup exe file. 

o Follow the setup instructions. 

• Explain the different components and sections of a C++ program and their 
use. 

• Read about the basic structure of C++ program in the website 

http://www.cplusplus.com/doc/tutorial/program_structure/ 

Read about how to use Dev C++ in the website 

https://en.wikiversity.org/wiki/Installing_and_using_Dev-C%2B%2B 

 
Chapter	11	 Basic	Elements	of	C++		



Objective:   

• To learn about character set, variable and constants in C++. 

• To learn about the basic data types supported by C++. 

• To learn about the various operators provided by C++ to perform various 
calculations and operations on variables. 

Guidelines 

• Explain to the students the following concepts in C++ 

o Characters supported by C++ 

o Different types of constants 

o Rules for naming variables 

o Different data types supported by C++ 

• Demonstrate the following concepts to the students 

o Declaring a variable 

o Using various operators on variables  

o Getting input and sending output to screen using cin and cout 
commands 

• Ask students to write and execute simple programs to learn the use of 
various data types and operators. 

• You can read more about C++ variables, data types , operators etc in the 
website 

https://beginnersbook.com/2017/08/c-plus-plus-tutorial-for-beginners/ 

 

 
Visual	Basic	

Chapter	1	 Introduction	to	Visual	Basic	



Objective:   

• To learn about GUI. 

• To learn about VB and VBA IDE. 

• To learn about creating, saving and running forms in VB project. 
Guidelines 

• Demonstrate to the students how to open VBA from Microsoft Excel. 

• If Microsoft Office is already installed in your computer, we can use the 
built-in Visual Basic Application in Excel to create the Visual Basic 
programs. 

• Point out the different parts of the VBA window and explain their use. 

• Demonstrate to the students how to perform the following actions. 

o Making the hidden panels visible using View Menu 

o Adding a new form 

o Running a form 

o Exporting and Importing a form 

o Saving a VB project 

• You can read more about VBA in this website 

https://www.guru99.com/vba-tutorial.html 

 
Chapter	2	 Tools	in	Visual	Basic	

Objective:   

• To learn about the controls available in the Toolbox in VBA and their use. 

• To learn about events and how to add them using Code window in VBA. 

• To learn about how to change background color of form. 

• To learn how to activate an event in VB form. 



• To learn the use of MsgBox command  

• To learn the use of CommandButton, Image, Label and TextBox  controls in 
VBA. 

Guidelines 

• Point and tell the name and use of the controls in the VBA toolbox. Ask the 
students to draw the tools and write their name. 

• Demonstrate the following actions to the students 

o Adding events using Code Window 

o Changing background of the form 

o Displaying message dialog box 

o Using CommandButton to execute code 

o Displaying pictures using Image control 

o Displaying text and numbers using Label control 

o Accepting input from user using TextBox control 

o Putting comments in the code 

• Encourage the students to experiment with the different properties of the 
controls to change the foreground/background color, height, width, border, 
font etc. 

• You can read more on the use of the tools in the website. 

https://msdn.microsoft.com/en-us/vba/language-reference-
vba/articles/toolbox 

Chapter	3	 Programming	in	VB	

Objective:   

• To learn about the programming fundamentals of Visual Basic. 

• To learn about the variables, data types and operators in VB. 

• To learn about the control statements used in VB code. 



Guidelines 

• Explain and demonstrate the following concepts to the students. 
o Using variables in VB programming. 
o Data types supported by VB. 
o Operators supported by VB. 
o Controls statements used to write VB code. 

• Ask the students to practice the use of the different types of Do-Loop.  
• Read more about data types, operators and control statements in VB 

programming in this website. 
https://www.guru99.com/vba-data-types-variables-constant.html 
http://www.excelfunctions.net/VBA-Operators-And-Functions.html 
https://analysistabs.com/excel-vba/conditional-statements/ 
 

Chapter	4	 Selection	Controls	in	VB	

Objective:  To learn how to add the selection controls to the VB form and to use 
their properties in the code. 
Guidelines 

• Demonstrate to the students the following actions in VBA 

o To add an OptionButton control to the form and find the selected 
option. 

o To add a Frame control to the form to hold a group of controls. 

o To add a CheckBox control to the form and find the selected options. 

o To add a ListBox control to the form, add Items to the ListBox and find 
the selected items. 

o To add a ComboBox control to the form, add Items to the ComboBox 
and find the selected items. 

• The ComboBox control in VBA toolbox has only two styles- Dropdown Combo 
and Dropdown List.  



• Demonstrate to the students how the List box and ComboBox behaves for 
different values of the MultiSelect Property and Style Property, respectively. 

• You can read about the selection controls in VBA in this webpage. 
http://excelvbatutor.com/index.php/excel-vba-lesson-23-listbox-combobox/ 
 

Macromedia	Flash	

Chapter	5	 Introduction	to	Macromedia	Flash	

Objective:   
• To learn the basic terminologies related to computer graphics. 
• To learn about Macromedia Flash, the different components of Flash 

Workspace and their use. 
• To learn about the various tools in Flash and their uses. 

 
Guidelines 

• The lessons and snapshots included in this text book are based on the version, 
Macromedia Flash 8 Professional. 

• You can download Flash 8 from the website. 
https://qpdownload.com/macromedia-flash-8/ 
https://qpdownload.com/macromedia-flash-8/ 
 

• Demonstrate to the students how to launch Flash in their computer. 
• Point and tell the name and use of the parts of Flash Workspace and the 

various Flash tools. 
• You can read more about Flash workspace and tools in this website. 

http://www.teacherclick.com/flash8/index.htm 
 

Chapter	6	 Using	Flash	Tools	

Objective:  To learn how to work with various tools in Flash. 
Guidelines 



• Demonstrate to the students the following actions in Flash 

o To create a new file, open existing files, save and publish the file into 
other file formats 

o To change the Stage Properties  

o To draw a circle/oval 

o To align objects on stage 

o To draw a straight or freeform lines 

o To add or apply fill color to shapes and objects 

o To apply gradient transform 

o To use Free Transform tool 

o To draw a polygon/polystar 

o To group and ungroup objects 

o to add text to the Flash animation 

o To use Webdings font for adding graphics 

• You can read more about the use of the drawing and text tools in this 
webpage. 

http://www.teacherclick.com/flash8/t_4_1.htm 

http://www.teacherclick.com/flash8/t_5_1.htm 

 
Chapter	7	 Animations	in	Flash	

Objective:  To learn to create different types of animations in Flash. 
Guidelines 
• Explain to the students the use of Timeline, keyframes and layers in Flash 

animation. 
• Demonstrate to the students the following actions in Flash 

o Add a Blank/ Keyframe in the timeline  
o To delete frames from the timeline 



o To create, rename, move, copy , delete, lock and hide layers  
• Explain to the students the different types of animations in Flash. 
• Demonstrate to the students the following action in Flash 

o To Import an image to the stage 
o To create Frame-by-Frame animation by adding keyframes 
o To run the flash movie 
o To adjust the speed of the animation 

• Explain and demonstrate the use of brush tool and the different brush modes. 
• Demonstrate to the students how to create Shape Tween and Motion Tween 

animations.  
• You can read more about flash animations in this website. 

http://www.teacherclick.com/flash8/t_14_1.htm 
 

Chapter	8	 Symbols	in	Flash	

Objective:  To learn how to create and use different types of Symbols in Flash to 
reuse the graphics and reduce the file size. 
Guidelines 
• Explain to the students the three types of symbols – Graphic, MovieClip and 

Button. 
• Demonstrate to the students how to  insert a new symbol and to Convert a 

Flash object to a symbol 
• Explain and demonstrate the use of Motion path to move a symbol in a specific 

path and also to use the Rotate option of Motion Tween 
• Explain and demonstrate how to create a button symbol and the use of the 

four frames - Up, Over, Down and Hit. 
• Explain and demonstrate the use of Swifty font to animate a human figure and 

also to edit multiple frames at the same time. 
• You can read more about the symbols in flash in this website. 

http://www.teacherclick.com/flash8/t_9_1.htm 
 

C++	



Chapter	9	 Program	Statements	in	C++	

Objective:  To learn about the different types of programming statements in C++. 
 
Guidelines 
• We already covered the basic elements of C++ including the various data types 

and operators in Class 8 Textbook. Refer Class 8 textbook for the use of 
operators and data type in C++. 

• Orwell Dev-C++ is a free full-featured integrated development environment 
(IDE) distributed under the GNU General Public License for programming in C 
and C++. 

• To install the Dev-C++ software,   
F Download Dev-C++ from https://sourceforge.net/projects/orwelldevcpp/ 

 
F Double click on the setup exe file. 
F Follow the setup instructions.  
F Start Dev-C++ using the Start menu or desktop shortcut. 
F To open a new file , select the New option in the File Menu. 
F To compile the program, click on the Execute menu and select the Compile 

option OR press the keyboard shortcut key F9. 



F To run the program, click on the Execute menu and select the Run option 
OR  press the keyboard shortcut key F10. 

• Demonstrate to the students how to use the C++ editor to open, edit, save, 
compile and run the programs. 

• Explain and demonstrate the use of sequential, condition and looping 
statements in C++. 

• Explain and demonstrate the use of String class in C++ to store words and 
sentences. 

• You can read more about writing C++ code using different programming 
statements in this web page. 
http://www.cplusplus.com/doc/tutorial/control/ 
 

Chapter	10	 Data	Structure	and	Functions	in	C++	

Objective:  To learn about using functions and various data structures in C++. 
 
Guidelines 

• Explain and demonstrate to the students how to use Array data structure to 
store collection of elements of same data type. 

• Explain and demonstrate the use of functions to divide the programs in to 
logical segments of code. 

• Explain and demonstrate the use of Structure combine and store data items of 
different types. 

• You can read more about data structures and functions in C++ in the website. 

http://www.cplusplus.com/doc/tutorial/arrays/ 

http://www.cplusplus.com/doc/tutorial/structures/ 

http://www.cplusplus.com/doc/tutorial/functions/ 

 

 
Chapter	1	 Database	Concepts	



Objective:   
• To learn about the role of database in organizing the data in an efficient 

and meaningful way. 
• To learn about DBMS and their different types 
• To learn about DMBS architecture 

Guidelines 
• Discuss with the students about the following topics: 

o Examples of data and information around us. 
o Examples of database around us such as textbook, library catalogue, 

and attendance register 
• Ask the students to find out about the popular DBMS products used in the 

industry today.  
• Explain to the students the different types of DBMS. 
• Draw and explain DBMS architecture. 
• You can read about DBMS in the website. 

https://www.studytonight.com/dbms/overview-of-dbms.php 
https://www.studytonight.com/dbms/database-model.php 

	

Chapter	2	 Entity-Relationship	

Objective:  	

• To learn about E R Model and how it is used for designing a database. 
• To learn how to draw E R diagram to represent entities and relationships 
• To learn about RDBMS and how it is used to store data in the form of 

tables. 
 
Guidelines 

• Discuss with the students about the various entities that exist around us, 
their attributes and the types of relationship between the entities. 

• Explain E R model and its components 
• Explain and demonstrate E R diagram to represent entity and relationship 
• Explain different types of relationships using cardinalities. 



• Explain about RDBMS and the various terms used like table, field, record 
and key. 

• You can read about ER model and RDBMS in this website. 
https://www.studytonight.com/dbms/er-model-concepts.php 
https://www.studytonight.com/dbms/rdbms-concept.php 
 
SQL	

Chapter	3	 Introduction	to	SQL	

Objective: 
• To learn about the different SQL statements and their use. 
• To learn about the use of different SQL constraints 
• To learn about the different data types supported by SQL. 
 
Guidelines 

• Explain the use of different types of SQL commands, constraints and data 
types to the students. 

• You can read more about SQL constraints, data types and commands in the 
website. 
https://www.studytonight.com/dbms/introduction-to-sql.php 
https://www.studytonight.com/dbms/sql-constraints.php 
https://www.w3resource.com/sql/data-type.php  

	

Chapter	4	 Programming	in	SQL	

Objective: 
• To learn to write and execute SQL statements to add, retrieve and modify data 

in a database. 
• To learn to execute query in SQLiteStudio. 
 
Guidelines 



• SQLite is the most deployed database engine in the world and is widely used 
by browsers, operating systems and embedded systems (such as mobile 
phones). 

• SQLiteStudio, which is a SQLite database manager, has been used to execute 
the different SQL commands specified in the textbook. However, the SQL 
commands will work in any other database engine like MS SQL server, MySQL 
etc. 

• SQLiteStudio is a free, open source SQLite database manager released under 
GPL license. It doesn’t require any installation. The tool can be launched by 
running the executable file available as part of the download. 

• SQLiteStudio can be downloaded in the Windows binary version from the 
official website- https://sqlitestudio.pl/index.rvt.  

 
• The downloaded file is in the ZIP format. Extract the files in to a folder in your 

computer. 
• Demonstrate to the students the following actions in SQLiteStudio 

o Starting the SQLiteStudio application 
o Adding a new Database 



o Connecting to a Database 
o Opening the SQL Editor 
o Executing a query in the SQL Editor 
o Viewing the results and errors. 

• Demonstrate to the students the use of the following SQL commands	
o Creating a Database 
o Removing a Database 
o Creating a Table 
o Removing a Table 
o Modifying the Table Definition  
o Adding Rows to a Table 
o Retrieving  or displaying Data from a Table 
o Modifying Data in a Table 
o Removing Rows from a Table 

• You can read more about SQL commands in the website. 
http://beginner-sql-tutorial.com/sql-commands.htm 

 

Chapter	5	 SQL	Clauses	

Objective:  
• To learn the use of some commonly used SQL Clauses. 
• To learn how to use the SQL Group functions 
• To learn about the use of Foreign key constraint  
• To learn how to join tables to retrieve data 
Guidelines 
• Demonstrate to the students the use of the following SQL clauses	

o ORDER BY  
o DISTINCT  
o LIKE  
o AND and OR Operators 
o BETWEEN Clause 
o IN Clause 



• Explain and demonstrate the use of SQL Group functions which return one 
value for the entire group 

• Explain and demonstrate the use of FOREIGN KEY constraint to link tables. 
• Explain and demonstrate how to join tables to retrieve data. 
• You can read more on group functions and join  in this website. 
https://www.studytonight.com/dbms/sql-function.php	

https://www.studytonight.com/dbms/joining-in-sql.php	

JAVA	

Chapter	6	 Introduction	to	Java	

Objective:  

• To learn about the fundamentals of Java language. 
• To learn about the uses of Java in the real life applications 
• To know about the various features of Java 
Guidelines 

• Explain to the students the following concepts 
o POP & OOP 
o Origin of Java 
o Uses of Java 
o Features of Java 
o Differentiation of JRE, JVM & JDK 

• You can read more about java in the website 
https://www.studytonight.com/java/overview-of-java.php 
https://www.studytonight.com/java/features-of-java 
https://www.studytonight.com/java/component-of-java 

Chapter	7	 Object	Oriented	Programming	

Objective  

• To learn about the basic concepts of Object Oriented Programming. 
• To learn how to work in Dr. Java to create and execute java programs. 



• To learn about basic syntax and structure of Java programs. 
Guidelines 
• Explain to the students various examples of class and objects around us. For 

example, Company is class and a specific company, like Infosys is an object. 
• Explain the concepts of Encapsulation, Abstraction and Inheritance. For 

example, from the super class Company, we can derive sub classes for 
different types of company like IT, Textiles, Electronics etc. 

• Explain the basic syntax and structure of Java programs. 
• DrJava is a lightweight development environment for writing Java programs. It 

is designed primarily for students, providing an intuitive interface and the 
ability to interactively evaluate Java code. DrJava is available for free under the 
BSD License, and is developed by the JavaPLT group at Rice University. 

• The jar file can be downloaded from the official website 
http://www.drjava.org/.   We can simply double-click the jar file to start DrJava 
or we can create a shortcut to the jar file on the desktop.  

 
• You need to have JDK and JRE installed in the system to run DrJava and to 

develop Java applications. You can download JDK from the official Oracle 
website: 
http://www.oracle.com/technetwork/java/javase/downloads/index.html 



 
• Demonstrate to the students the following in Dr Java 

o Opening Dr Java 
o Writing and saving a program in Dr Java 
o Compiling and running a program 

• You can read more about using Dr Java , OOP concept and Java syntax in this 
website 

http://www.drjava.org/docs/quickstart/	

https://www.studytonight.com/java/object-and-classes.php	

https://www.studytonight.com/java/first-java-program	

https://www.tutorialspoint.com/java/java_basic_syntax.htm	

	

Chapter	8	 Fundamentals	of	Java	

Objective 



• To learn about data types, operators and control structures in Java, which are 
very much similar to C++. 

• To learn about Math class and their methods 
• To learn about String class and their methods 
 
Guidelines 
• The data types, operators and control structures supported by Java are similar 

to C++. We have already covered about the variables, data types, operators 
and control structures in C++ in Class 8 and Class 9. Refer the Computer 
Creations Class 8 and 9 for further details. 

• Explain and demonstrate the following concepts to the students 
o Primitive data types supported by Java and their use 
o Different operators provided by Java and their use 
o Control statements in Java 
o Use of Math class and the methods in it 
o Use of String class and the methods in it. 

• Demonstrate the precedence of java operators using various expressions. 
• You can read more about data types, operators, control statements, Math and 

String class in the website. 
https://www.studytonight.com/java/datatypes-and-identifier 
https://www.studytonight.com/java/operators-in-java 
https://www.tutorialspoint.com/java/java_loop_control.htm 
https://www.tutorialspoint.com/java/java_decision_making.htm 
https://www.tutorialspoint.com/java/java_strings.htm 
https://www.tutorialspoint.com/java/lang/java_lang_math.htm 
 

 
Chapter	9	 Working	with	Java	Objects	

Objective:  
• To learn how to create objects from class and use their members and 

methods. 
• To learn about different types of constructors 



• To learn how to accept user input from console in Java program 
• To learn how to send data through command line arguments 
• To learn how to use array in Java program 
 
Guidelines 
• Explain and demonstrate to the students how to do the following in Java 

o Design a Java class 
o Create an object from a class 
o Use the class and object in the program 
o Use of constructors 
o Input data through console in java program 
o Send data via command line while executing 
o Use Interaction tab in Dr java to run program 
o Use array to store sequence of data in java program 

You can read more about working with class and object in java in the website. 
https://www.studytonight.com/java/constructor-in-java.php 
https://www.studytonight.com/java/command-line-argument 
https://www.studytonight.com/java/array 
https://www.geeksforgeeks.org/scanner-class-in-java/ 
 
Chapter	10	 Polymorphism	and	Inheritance	

Objective: To learn how to incorporate inheritance and polymorphism in Java 
programs. 
 
Guidelines 

• Explain the concept of Inheritance and Polymorphism using real life objects 
like people, company, product, vehicle etc. 

• Ask students to come up with various variables and methods for the above 
classes. 

• Demonstrate to the students the concept of compile time and run time 
polymorphism using method overloading and method overriding in Java 
programs. 



• Demonstrate the use of inheritance by creating sub classes from parent class 
using extends keyword. 

• You can read about polymorphism and inheritance in the website. 

https://www.studytonight.com/java/inheritance-in-java.php 

https://www.studytonight.com/java/method-and-overloaded-method 

https://www.studytonight.com/java/method-overriding-in-java 

https://www.studytonight.com/java/dynamic-method-dispatch 

 

 

 

 


